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Resumo

O presente artigo tem por objetivo discutir, perceber e dar a conhecer a importância 

dos montantes associados à aquisição/renovação de licenças de software, em particular, 

Software SIG, por parte de instituições públicas portuguesas, entre 2008 e 2013. Para este 

efeito, destacamos a inventariação e análise efectuadas aos dados contratuais disponíveis 

em plataformas públicas online de acesso Livre, como a Base.gov, relativos a instituições 

ligadas ao ensino superior e a instituições cuja moldura estatutária as enquadra na estrutura 

administrativa pública do Estado Português. Este ensaio justifica-se pela dinâmica crescente 

que o Software Livre/de Código Aberto tem vindo a protagonizar, em particular na última 
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década, o que se traduz numa oferta plural de aplicações interoperáveis de elevada quali-

dade em termos de desempenho e em termos de soluções que permitem que o utilizador 

de SIG disponha de opções de grande valor quando confrontadas, directa ou indirecta-

mente com os software comerciais de referência. Assim, e tendo como linhas orientadoras 

para esta pesquisa as filosofias identitárias do Software Livre/Open Source e a imposição 

recente, pelo Orçamento de Estado de 2013, da utilização de Software Livre quando existe 

essa possibilidade (segundo o próprio documento, apenas poderá ser utilizado Software 

Proprietário nos casos que seja fundamentadamente demonstrada a inexistência de soluções 

alternativas em Software Livre ou que o custo total de utilização da solução em Software 

Livre seja superior à solução em Software Proprietário…), pretende-se discutir vantagens e 

desvantagens da utilização deste tipo de software, relativamente ao Software Proprietário. 

Pretende-se, ainda, avaliar a necessidade ou simples desejo de migração para o Software 

Livre, motivada por uma decisão pessoal e/ou apenas pela lógica da boa gestão de recur-

sos, designadamente económicos - por definição, limitados e, estrutural e conjunturalmente 

escassos em Portugal. Como suporte da decisão de migração desenvolvemos também um 

ensaio comparativo entre alguns dos Software SIG de Código Aberto que têm vindo a cativar 

mais adeptos e o Software SIG Comercial, referência no mercado. Este ensaio permitiu-nos 

avaliar e concluir sobre o desempenho de ambas as categorias de software em confronto, 

designadamente, em contexto de manipulação e execução de tarefas de geoprocessamento 

com grandes volumes de dados, factor que releva quando somos confrontados com esco-

lhas e decisões de utilização, em que “trunfos” e “fragilidades” deverão ser objecto de um 

balanço sério, rigoroso e fiável. A dúvida cartesiana que orientou a busca de uma respos-

ta para este interessante desafio partiu de reflexões simples que se poderiam expressar 

de acordo com a seguinte redacção: “Quanto gastam as nossas instituições públicas com 

Software Comercial ?“; “Serão as diferenças de desempenho entre Software Comercial e 

Software Livre suficientes (e suficientemente importantes) para justificar os assinaláveis 

custos acometidos à aquisição e renovação de licenças de Software Comercial, tanto mais 

que se trata de dinheiros públicos?” 

Palavras-chave 

Software SIG Livre/Software SIG Proprietário, Custo, Liberdade, Administração pública.

A GIS-based raft

at the Public Portuguese Administration

Abstract

The main goal of this paper is to discuss and to understand the costs involved in the ac-

quisition/renewal process related to commercial Software, particularly of GIS Software, in 
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public portuguese Institutions, for the time period of 2008-2013. We highlight the contracts 

(access free) available at the digital public platforms, such as Base.gov, concerning muni-

cipalities, universities and other institutions that fit in the public administrative structure 

of Portugal. This essay is justifiable by the increasing use of Free & Open Source Software, 

particularly in the last decade, resulting in a widespread frame of interoperable and highly 

performing applications. Such Open Source solutions provide valuable solutions for GIS 

technicians and users, even if compared with commercial Software. Having as a guideline 

for this research the recent imposition of the Portuguese Budget for the year 2013, which 

stresses the principle of mandatory using of the Free Software when appropriate solutions 

are available, we intend to discuss the pros and cons of using this kind of software having 

into account the commercial alternatives and related costs. It is intended also to assess the 

need/desire of drifting from commercial to Free and Open Source GIS Software, a decision 

that, although personal, should be supported by the goal of reaching an efficient way for 

economic resource management. In support of the decision to this migration process a 

comparative test of performance was made between some of the open source GIS soft-

ware that have been captivating fans and most major commercial GIS software. This test 

allowed us to evaluate and conclude on the performance of both categories of software 

in confrontation, particularly in the context of geoprocessing tasks for large volumes of 

data. Strengths and weaknesses should thus be the subject of a rigorous and reliable as-

sessment. The cartesian/methodic doubt that guides us into the search for an answer to 

this interesting challenge started from simple questions that could be expressed according 

with the following sentences: “How much does portuguese public institutions spend with 

commercial Software?”; “Are the performances of commercial Software and Open Source 

Software, different enough to justify the notable costs related with the acquisition and 

renewal of commercial licenses, especially as it comes to public money?”

Keywords

GIS Free & Open Source Software/GIS Commercial Software (Payware), Cost, Freedom, 

Management of public administration.

1. Introdução

O crescimento acentuado da utilização de Sistemas de informação geo-

gráfica (SIG) tem vindo a conduzir a um aumento assinalável na procura 

de Software de Código Aberto (ou Livre). É, diríamos, o fôlego pleno da 

actual fase de democratização dos SIG! No caso específico de Portugal, 

e apesar de existirem várias soluções de Software de Código Aberto, 

continua a existir uma elevada despesa pública no que concerne à aqui-
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sição e manutenção de licenças para utilização de Software Proprietário 

em todos ou, pelo menos, grande parte dos sectores públicos como, en-

tre outros, a Educação (ensino superior e básico), Administração Local 

(serviços municipalizados, câmaras e empresas), Administração Central 

ou Regional, Empresas de Gestão do Território (gestão de energia, trans-

portes, recursos, resíduos, planeamento e ordenamento, etc.) e a Saúde. 

Uma simples pesquisa pela plataforma digital de Contratos Públicos 

Online - Base.gov, despertou a atenção e o interesse em saber “quanto 

gastamos?” e tentar estimar “quanto poderíamos poupar?” se encontrás-

semos no Software Livre, soluções alternativas, atractivas e (con)fiáveis. 

E elas existem, como adiante vamos comprovar.

Salientamos o facto de a letra do próprio Orçamento de Estado de 

2013 convidar já, para não dizer impor com subtileza, à utilização do 

Software Livre quando essa possibilidade existir. De acordo com a direc-

triz nº1 do Artigo 4º do Capítulo II (Utilização das dotações orçamentais 

para Software informático), “As despesas com aquisição de licenças de 

Software, previstas nas rubricas ‘Software Informático’ dos orçamentos dos 

serviços integrados e dos serviços e fundos autónomos, apenas poderão 

ser executadas nos casos em que seja fundamentadamente demonstrada 

a inexistência de soluções alternativas em Software Livre ou que o custo 

total de utilização da solução em Software Livre seja superior à solução 

em Software Proprietário ou sujeito a licenciamento específico, incluindo 

nestes, todos os eventuais custos de manutenção, adaptação, migração 

ou saída” (sic). 

Este artigo decorre do desafio lançado pelo Professor José Gomes 

aos mestrandos do curso TIG, no âmbito da unidade curricular de SIG 

e Open Source do Mestrado em Tecnologias de Informação Geográfica 

(TIG), da Universidade de Coimbra, no sentido de se efectuar um levan-

tamento exaustivo dos custos envolvidos com a utilização de Software 

Proprietário na gestão da coisa pública. Lançado este desafio, que foi aceite 

pela maioria dos mestrandos, procedeu-se à redacção de um curto texto 

cujo objectivo principal consistia em plasmar os resultados decorrentes 

da investigação que nos levaria a encontrar eventuais respostas para o 

problema de raiz, que aqui recordamos: “Identificar e avaliar os custos 
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de aquisição/renovação de licenças de software, em particular Software 

SIG, no período definido entre os anos de 2008 e 2013, por parte de 

instituições públicas portuguesas”. Por outro lado, ocorreu-nos avaliar 

o desempenho de alguns dos Software SIG Livres mais utilizados numa 

lógica de confronto directo com a grande referência do Software SIG 

Proprietário, de modo a que se conseguisse perceber que tipo de soluções 

alternativas em Software SIG Livre/Código Aberto existem no mercado.

É certo que um exercício desta natureza, seja ele qual for desde que 

seja imparcial, nunca será imune a críticas e isento de fragilidades, sejam 

quais forem as tarefas eleitas para a materialização de um teste com-

parativo de desempenho entre software semelhante (veja-se, a título de 

exemplo, o trabalho de SÁTIRO & SIMÕES, 2013).

Sabendo que, de um modo geral, os Software SIG Livre realizam já a 

grande maioria das tarefas processuais que qualquer Software Proprietário 

coloca à disposição dos utilizadores, podendo até acrescentar-se que 

muitas dessas tarefas são até mais expeditas, mais rápidas, mais intui-

tivas ou, mesmo, mais aprazíveis de realizar tendo em consideração a 

versatilidade e o aspecto gráfico das interfaces que nos disponibilizam as 

várias aplicações de Software Livre, moveu-nos, sobretudo, a curiosidade 

de saber como se comportariam estes software em situações extremas, 

designadamente, quando têm de lidar com grandes volumes de dados. 

E nesta rubrica, o Software SIG Livre tem, ainda, um caminho árduo a 

percorrer para se comparar com a grande referência do sector. Não obs-

tante, estamos convictos, em absoluto, de que se procedeu a um ensaio 

metodológico sério, desprovido de qualquer tipo de interesses dado ser 

absolutamente imparcial e isento em termos éticos, técnicos e científicos. 

Os resultados que em fase mais adiantada deste trabalho se apresentam 

ficam, por essa razão, para reflexão, seja ela de natureza pessoal ou co-

lectiva, e para que a comunidade de desenvolvedores de Software SIG 

Livre possa cuidar de atacar algumas das fragilidades que persistem. Não 

temos outro desiderato que não este, e procedemos à realização deste 

exercício complementar ao cerne da temática que confere assinatura ao 

presente artigo, porque estamos absolutamente convictos da força do 

Software SIG Livre e da necessidade da sua utilização na administração 
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pública em Portugal. 

2. Apresentação do tema 

No amplo universo dos Software SIG/WebSIG gravitam várias soluções 

fiáveis de Software Livre tais como, gvSIG, QGIS, Grass, PostgreSQL/

PostGIS, Kosmo, ILWIS, Spring, Saga GIS, entre outros. Mas o que é 

afinal o Software SIG Livre? Em primeiro lugar, importa distinguir entre 

Software Livre e Software de Código Aberto (Gonçalves, 2012). O conceito 

de “Software Livre”, enquadra-se numa filosofia/movimento organizado 

que surgiu em 1983 e em 1984. Richard Stallman dava início ao projecto 

GNU (Gnu is Not Unix) e posteriormente, em 1985, estaria na base da 

génese da “Free Software Foundation” (FSF), adoptando como filosofia a 

premissa da livre troca de conhecimento e pensamentos, ao abrigo das 

quais estaria incluído o Software Livre.

Tal como as ideias, os programas de computador não são tangíveis mas 

podem ser copiados sem perdas. A sua distribuição é a base de um pro-

cesso de evolução “tão livre como em liberdade” (STALLMAN & WILLIAMS, 

2010) que alimenta o desenvolvimento do pensamento. Com base neste 

princípio, os utilizadores de Software Livre podem livremente executar, 

copiar, distribuir, estudar, mudar e melhorar o Software (controlo do 

programa e daquilo que ele faz pelo utilizador), o que faz da “liberdade” 

um conceito chave nesta filosofia, que chega formalmente aos SIG através 

da criação, em 2006, da “Open Source Geospacial Foundation” (OSGeo). 

É, pois, importante respeitar as quatro liberdades (http://www.gnu.

org) formalizadas pelo próprio postulado de Richard Stallman, ou seja: 

i) executar o programa para qualquer propósito;

ii) estudar o funcionamento de um programa (via código-fonte) e adaptá-
-lo às necessidades de cada um;

iii) redistribuir a terceiros, cópias das suas versões, possivelmente já 
modificadas;

iv) Melhorar (desenvolver) o programa de modo a que as modificações 
se tornem públicas para que a comunidade inteira beneficie da melhoria.
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O acesso ao código-fonte é, portanto, um pré-requisito. Engane-se, 

contudo, quem pense que este software funciona sem qualquer tipo de 

licenciamento, pois ao projecto GNU, lançado por Stallman, está associada 

uma licença, a General Public License (GNU-GPL ou apenas GPL), que 

não só concebe as quatro liberdades, como as protege, o que faz dela a 

licença mais utilizada para o Software Livre. O seu objectivo é garantir 

a liberdade de utilização e mantê-la em projectos derivados de software 

originalmente Livre. 

De facto, segundo a FSF o único software realmente Livre é aquele 

que se distribui mediante a licença do tipo GPL com Copyleft, visto que 

é aquela que garante a liberdade não só dos utilizadores actuais como a 

dos futuros (GONÇALVES, 2012). Todavia, neste contexto existiam outras 

licenças como a Apache ou a Berkeley Software Distribution (BSD) que 

não tinham as obrigações Copyleft. É então, aqui criado o movimento 

“Open Source Iniciative” (OSI), que não ignora as liberdades básicas 

do Software Livre, mas tenta ser mais flexível do ponto de vista das ne-

cessidades comerciais das empresas implicadas na criação, distribuição 

e utilização de Software Livre (GONÇALVES, 2012). Assim, o software 

desenvolvido em Código Aberto mantém as liberdades fundamentais do 

Software Livre, mas retira o conceito de Copyleft, pois considera que a 

distribuição posterior de projectos modificados deve permanecer flexí-

vel, deixando ao critério dos programadores a possibilidade de manter o 

Software Livre ou de o tornar Proprietário. Tirando isto, segundo Gonçalves 

(2012), as diferenças conceptuais entre estes dois conceitos são apenas 

uma questão de postura/enfoque e concepção filosófica. Neste sentido, 

todo o Software Livre é Open Source só que nem todo o Software Open 

Source é necessariamente Livre. 

Considerando as vantagens e as desvantagens deste tipo de software 

e comparando-o com o Software Proprietário, começamos por salientar 

que o Software Livre é, como foi já dito, caracterizado por ter o código-

-fonte aberto e por poder ser distribuído publicamente, ou seja, é de 

livre acesso a qualquer utilizador. Em contrapartida, o código-fonte do 

Software Proprietário assenta num conceito de “black box”, fechado, 

secreto, de propriedade exclusiva e com direitos de patente (Copyright), 
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estando assim protegido por Direitos de Autor1.

Ao utilizador é vendida uma licença para fins específicos, a qual pode 

custar desde centenas a milhares de euros, sendo celebrado um contrato 

restritivo de direitos do utilizador, entre os quais a cópia fraudulenta e 

distribuição do software sem autorização formal de licenciamento - vulgo, 

cópia pirata (crack).

Torna-se importante salientar, no entanto, que também em Portugal 

são já conhecidas boas práticas associadas a iniciativas de migração para 

o uso do Software SIG Livre, protagonizadas por várias instituições/orga-

nismos públicos, tanto ao nível da Educação (indo ao encontro das ideias 

defendidas por PINHO, 2011) como da Administração e Gestão Territorial. 

Destacam-se, por exemplo, a escola do Funchal - Secundária Jaime Moniz 

(curso Tecnológico de Ordenamento do Território e Ambiente) onde se 

utiliza QuantmGIS (QGIS), bem como o Departamento de Geografia da 

Faculdade de Letras da Universidade de Coimbra com a implementação, 

em 2012, do Software gvSIG na Licenciatura em Geografia. Ainda na 

Universidade de Coimbra, a criação de uma unidade curricular no mestrado 

em Tecnologias de Informação Geográfica (TIG - FLUC/FCTUC), na qual 

se utiliza mais de uma dezena de aplicações SIG/WebSIG Open Source, 

foi um passo consolidado e seguro num caminho que se entende por 

razoável, sensato e - diz-se, de reconhecido mérito. Também outras áreas 

da Administração Pública relevam neste exercício, vejam-se os exemplos 

da CM de Arraiolos, CM Mealhada, CM Oliveira de Azeméis, CM Mirandela, 

entre outras, em elevado e crescente ritmo de adesão, exemplos de boa 

gestão de recursos que demonstram que “se o Software Proprietário faz, 

o Software Livre, também faz”. 

Através dos ensinamentos que estes exemplos de reconhecidas “boas 

práticas” na utilização de Software SIG Livre nos dão, percebem-se melhor 

as vantagens em utilizar soluções SIG de nulo ou baixo custo, opção em 

relação à qual, mesmo que possam ser apontadas algumas limitações, 

insuficiências, condicionantes, ou fragilidades, elas são facilmente desmon-

1 No Software Livre, os Direitos de Autor do código-fonte de origem numa aplicação 
também são preservados, desde logo, pelo próprio espírito das licenças GPL. A propósito 
deste assunto, veja-se o que nos diz o trabalho de Pereira (2012) na sugestiva obra intitu-
lada “Normas Abertas nos Sistemas Informáticos do Estado: Quo Vadis?”.
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tadas devido ao trabalho da vasta comunidade de utilizadores dispostos 

a monitorizar, gerir e melhorar as funcionalidades do software, o que 

faz com que os handicap invocados, na prática, não passem de um mito. 

O conceito de “Comunidade” ganha uma expressão fulcral no âmbito 

do desenvolvimento e utilização de Software Livre, e fundamenta-se no 

princípio de que “muitos olhos vêem melhor” (SANTOS et al., 2009).

3. Apresentação dos dados e descrição da metodologia utilizada

Do ponto de vista das metodologias utilizadas, a ordem de trabalhos 

contemplou três pontos principais.

i) Um inventário exaustivo dos dados armazenados na web (http://www.

base.gov.pt/base2/), depois de identificados os critérios para a pesquisa, 

a saber:

a. Dados relativos a despesas das instituições de Ensino Superior e da 
Administração Pública, em geral, com aquisição/manutenção de licenças 
de Software SIG Proprietário;

b. Dados relativos a despesas das instituições de Ensino Superior e 
da Administração pública, em geral, com a aquisição/manutenção de 
licenças de Software Proprietário relacionado com empresas produto-
ras de sistemas operativos que, em diante, será referido apenas como 
“S4OS” - acrónimo de Software for Operating Systems.

ii) Tentativa de quantificação e espacialização dos dados relativos aos gastos 

totais para ambos os itens acima referidos, considerando o período cro-

nológico de 2008-2013. A componente evolutiva foi também tida em linha 

de conta devido ao objectivo de se diagnosticar e perceber as tendências 

(se os gastos têm diminuído ou aumentado com o passar dos anos). Em 

jeito de reforço deste desiderato, tentámos perceber quais os sectores da 

Administração Pública que têm maior peso no total do “bolo” - leia-se, 

gastos com Software Proprietário, procedendo-se a uma classificação mais 

fina dos sectores identificados, de acordo com as seguintes classes:

a.	Educação;

b.	Serviços Municipalizados (sector da administração local);

c.	Administração Central e Regional;

d.	Empresas de Gestão do Território;
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e.	Saúde;

f.	 Segurança;

g.	Outros serviços.

A utilização de Software Livre específico (de SIG e de Estatística) 

permitiu-nos reunir a informação já processada de modo a procedermos 

às indispensáveis leituras e interpretação dos dados, e consequente apre-

sentação e discussão dos resultados. 

iii) A implementação de uma bateria de testes de desempenho compara-

do, nos quais estariam em confronto Software SIG Livre vs Software SIG 

Proprietário. Um ensaio desta natureza, como já referimos, será sempre 

subjectivo porque depende de vários factores, desde logo, das competên-

cias e dos conhecimentos do operador (e.g. instalação e utilização dos 

plugins adequados para as tarefas realizadas), mas também do tipo de 

tarefas de análise e de geoprocessamento a serem ensaiadas, bem como 

das condições de ensaio. A este nível, devemos salientar que os testes rea-

lizados com os software em confronto cuidaram de manter como elemento 

neutro todos os factores, conhecidos e parametrizáveis, que pudessem 

influenciar o desempenho do hardware (e.g. a configuração das máquinas 

em termos de velocidade de processamento e a minimização das tarefas 

simultâneas em curso - monitorizadas pelo gestor de tarefas), de modo a 

garantir as mesmas condições de funcionamento das máquinas aquando 

da realização dos testes de desempenho com cada uma das aplicações 

concorrentes. Definiu-se também, à partida, que as máquinas utilizadas 

para teste deveriam ser sempre as mesmas de modo a não falsear os re-

sultados obtidos para cada software. Optou-se por testes muito simples 

mas que envolveram o processamento de grande volume de dados, com 

recurso a tarefas comuns a todos os SIG. Foram utilizados os dois tipos 

de modelos de dados (matricial e vector) e formatos standard (“tiff” para 

matricial e “shapefile” para vector). A finalidade do exercício residiu, as-

sim, na avaliação do grau de desempenho dos software em confronto, em 

termos de velocidade de processamento de um considerável volume de 

dados e na capacidade do software em efectuar estas tarefas sobre uma 

quantidade bastante significativa de features e de células. Os exercícios 
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foram efectuados com sistemas operativos Windows (7 e 8) e, num caso, 

com Linux-Ubuntu (para que fosse possível avaliar o desempenho do 

Software Livre numa combinação plena, ou seja, com sistema operativo 

Livre e Software SIG Livre). Os testes de desempenho envolveram, assim, 

os seguintes software, nas suas últimas versões estáveis: 

a) Proprietário “X” (versão 10.2); 

b) QuantumGIS, futuramente designada apenas por “QGIS” (versão 2.2); 

c) gvSIG (versão 2.0); 

d) PostgreSQL/PostGIS.

Passamos a elencar os dados utilizados para geoprocessamento e os 

procedimentos/tarefas SIG executadas que nos permitissem obter rigoro-

samente os mesmos resultados sem ter de se recorrer a tarefas adicionais 

de pós-processamento2: 

 Dados:

- Carta de Risco de Incêndio Florestal (CRIF), 2011, em formato TIFF (um 

raster com 247 MB) e em formato Shapefile (um documento vectorial com 

1,33 GB e, aproximadamente, 3 500 000 de features), ambos disponíveis 

no endereço http://scrif.igeo.pt/cartografiacrif/2007/crif07.htm.

- Carta Administrativa e do Ordenamento de Portugal (CAOP), 2013, em 

formato Shapefile ( um documento vectorial com 52,4 MB e 3224 features), 

disponível no endereço http://www.dgterritorio.pt/cartografia_e_geodesia/

cartografia/carta_administrativa_oficial_de_portugal__caop_/caop__down-

load_/.

Tarefas de geoprocessamento utilizadas:

TAREFA A) Recorte do raster (CRIF) com base no limite administrativo 

do distrito de Coimbra (depois de efectuado um dissolve das freguesias 

- fonte CAOP, 2013)3 - Figura 1.

2  As tarefas executadas foram as nativas de cada software, sem se recorrer a processos 
de “GIStuning” com a instalação de plugins ou de add-ons.

3 Para o recorte do raster não se utilizaram pirâmides no software Proprietário nem 
overviews no QGIS e no gvSIG. 
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Figura 1 - Capturas de ecrã para as tarefas de recorte do raster (CRIF) efectuadas
pelos três software com base no limite administrativo do distrito de Coimbra

Fonte: CAOP, 2013 (depois de efectuado um dissolve das freguesias)

Algoritmos/comandos utilizados: 

1) Software Proprietário (Algoritmo desenvolvido em Python):

Toolbox > Data Management tools > Raster > Raster Processing > Clip 

> Configurar e executar

2) QGIS (Algoritmo desenvolvido em Python):

Menu Vector > Ferramentas de geoprocessamento > Cortar > Configurar 

e executar

3) gvSIG (Algoritmo desenvolvido em Java):

Camada Raster > Raster layer > Area of Interest (configurar com a 

shp distrito) > Camada Raster > Raster Process > Filter > Mask > add 

mask > seleccionar Region of Interest (ROI) previamente definida > 

Configurar (assinalar ”generate file”) e executar

TAREFA B) Corte topológico do vector (CRIF) com base no limite 

administrativo do distrito de Coimbra (depois de efectuado um dissolve 

das freguesias - fonte CAOP, 2013) - Figura 2.
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Figura 2 - Capturas de ecrã para as tarefas de corte topológico do vector (CRIF) 
efectuadas pelos três software com base no limite administrativo do distrito de Coimbra 

Fonte: CAOP, 2013 (depois de efectuado um dissolve das freguesias)

Algoritmos/comandos utilizados: 

1) Software Proprietário (Algoritmo desenvolvido em Python):

Toolbox > Analysis tools > Extract > Clip > Configurar e executar

2) QGIS (Algoritmo desenvolvido em Python):

Menu Vector > Ferramentas de geoprocessamento > Cortar > Configurar 

e executar

3) gvSIG (Algoritmo desenvolvido em Java):

Toolbox (Sextante) > Tools for vector layers > Clip > Configurar e executar

4. Apresentação dos resultados

4.1. Despesas com Software SIG Proprietário

Entre 2008 e 2013 o Estado português gastou 24 752 909,08 €, ape-

nas em Software SIG Proprietário. Mas se incluirmos valores relativos 

a Software for Operating Systems - S4OS (que inclui a mais conhecida 
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suite comercial de aplicações de escritório), o valor ultrapassa os 112 000 

000 €, informação que pode ser comprovada na Tabela 1 e na Figura 3.

Apesar de o presente trabalho resultar de um levantamento minucioso 

efectuado sobre uma base de dados pública oficial (Base.gov)4, optou-se 

pela omissão dos nomes apenas por uma questão de ética, até porque a 

sua menção não relevaria para a análise dos dados nem para a explicação 

dos resultados obtidos. Por outro lado, esta conduta permitiu preservar 

a isenção e a imparcialidade da investigação aqui retratada, princípio em 

que os autores se focaram ab initio, face a leituras várias e de diversa 

natureza que sobre ela pudessem recair, incluindo a perspectiva política, 

que não é de todo - sublinhe-se, bem-vinda a este documento.

Tabela 1 - Despesas de entidades públicas com Software Proprietário (SIG e S4OS)
em Portugal, por ano e por empresa produtora. (Fonte: Base.gov)

A observação atenta dos valores envolvidos não deixa margem para 

dúvida, quanto ao peso que os valores totais envolvidos nos contratos de 

aquisição e/ou manutenção de serviços informáticos para diversas áreas da 

Administração Pública representa para o Erário Público. Salientamos que 

estes valores dizem apenas respeito a algumas das principais empresas 

4  O Dec. Lei 18/2008 de 29/1 aprovou o Código de Contratos Públicos (CPP) que 
efectua a transposição das Directivas 2004/17/CE e 2004/18/CE (ambas do Parlamento 
Europeu e do Conselho, de 31 de Março) e codifica as regras, até então, dispersas pelos 
seguintes diplomas:

	 a) Decreto-Lei n.º 59/99, de 2 de Março (empreitadas de obras públicas)
	 b) Decreto-Lei n.º 197/99, de 8 de Junho (aquisições de bens e serviços)
	 c) Decreto-Lei n.º 223/2001, de 9 de Agosto (empreitadas e aquisições no âmbito 

dos sectores especiais)
	 d) Vários outros diplomas e preceitos avulsos relativos à contratação pública. 

(Fonte: Base.gov, disponível em http://www.base.gov.pt/base2/html/codigo/ccp.shtml). 

Atas das I Jornadas Lusófonas de Ciências e Tecnologias de Informação Geográfica, Sessão 8, Artigo 35
Jangada de SIG na administração pública portuguesa
Joaquim Patriarca, Sara Canilho, João Sacramento, Ricardo Correia, António Castro, Sara Santos, José Santos & Ricardo Pinho



565

fornecedoras de software (SIG ou S4OS) para o intervalo de tempo defi-

nido, e que foram considerados numa perspectiva de análise da evolução 

cronológica das despesas efectivas do Estado nesse período de tempo. 

A opção por este período cronológico não obedeceu a qualquer tipo de 

critério que não o da obtenção de dados confiáveis para um intervalo de 

tempo considerável, ante-câmara da grave crise económica que viria a 

deflagrar um par de anos mais tarde, e da entrada em vigor do próprio 

Orçamento de Estado (OE) para 2013 que, como se sabe, é profunda-

mente limitativo quanto à disponibilização de subsídios para aquisição 

de Software Proprietário havendo soluções alternativas em Open Source. 

Numa primeira reflexão sobre os dados, não podemos deixar de as-

sinalar a redução substancial dos custos com Software SIG relativos ao 

ano de 2013 (ano de entrada em vigor do OE 2013) - em mais de 50% -, 

comparativamente com o ano anterior. Este valor, relativo na sua expressão 

e significado, não pode ser descontextualizado, também, da tendência 

geral de subida e estabilização de custos que se verificou entre 2009 e 

2012, nem da assinalável subida em flecha dos custos com a aquisição 

deste tipo de software de 2008 para 2009 - que representa um aumento 

de aproximadamente 900% ! Estamos em crer que os valores de 2013 são 

para manter e acentuar a tendência de diminuição de custos, pelo que 

aguardamos, com expectativa, os dados relativos a 2014.

Numa leitura mais fina, que desce ao nível da liderança por empresa, 

destaca-se a Empresa A, claramente dominante no mercado português, 

mas que parece evidenciar uma rota de acentuada queda na sua expres-

são dominante, à semelhança do que se verifica com a outra empresa 

referência no sector - a Empresa E. As restantes empresas revelam um 

ritmo estacionário, em geral, de reduzida expressão, com excepção da 

Empresa B cujos valores envolvidos nos contratos com a Administração 

Pública portuguesa parecem não ter sentido o abalo introduzido pelo OE 

de 2013, comportamento que lhe permite estar já quase ao mesmo nível 

das empresas A e E, anteriormente referidas como claramente dominantes.
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Figura 3 - Quantificação dos gastos de instituições públicas portuguesas com 
Software SIG Proprietário, para o intervalo de tempo em apreciação, considerando 

apenas algumas das principais empresas fornecedoras. 
Fonte: Base.gov

Uma simples interpretação da informação disponibilizada na Figura 3, 

leva-nos a perceber que não parece existir qualquer tipo de correlação 

nem indicadores de um comportamento uniforme nos contratos estatais 

formalizados com as empresas consideradas; por exemplo, a Empresa 

“A” apresenta um pico de contratos/valores em 2010 (4 078 129 €), a 

Empresa “E”, por sua vez, tem um pico de vendas em 2011 (2 410 357 €), 

ano em se aproxima do valor despendido com software da Empresa “A”, 

com uma diferença de apenas 323 422 €. Curiosamente, este é também 

o ano em que mais se gastou com software produzido pela Empresa “B” 

(913 966 €). Isto pode indiciar que estes valores dependeram mais do 

timming escolhido por cada empresa para o lançamento de novas ver-

sões dos seus programas, o que se traduziu numa corrida à renovação 

de licenças. Todavia, neste ponto, o gráfico da Figura 4 revela uma outra 

perspectiva: se olharmos para os números na sua totalidade, sem serem 

discriminadas as empresas, o período cronológico considerado revela 

uma tendência para a descida dos custos totais com Software SIG a partir 

de 2010/11 apesar de a Empresa B e a Empresa E apresentarem os seus 

maiores volumes de negócio com o Estado português, precisamente em 

2011 (cfr. Figs. 3 e 4).
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Figura 4 - Variação e tendências dos totais da despesa pública com Software SIG 
Proprietário em Portugal, para o intervalo de tempo em apreciação, considerando 

apenas algumas das principais empresas fornecedoras. 
Fonte: Base.gov

A pesquisa por números e valores efectuada sobre a plataforma digital 

de contratos públicos Base.gov permitiu, também, organizar os dados por 

sectores de actividade e por área espacial. No que diz respeito aos secto-

res de actividade, os dados da distribuição dos gastos na Administração 

Pública com Software SIG (Tabela 2 e Figura 5) revelam resultados curiosos 

mas, igualmente preocupantes. Os Serviços Municipalizados foram os que 

mais gastaram (55%), seguindo-se os sectores estatais da Administração 

Central e Regional com 18% do total. No pormenor, destaca-se pela nega-

tiva, o facto de as Empresas de Gestão do Território quase duplicarem os 

gastos de 2012 para 2013, mesmo com a nova lei do OE. Já pela positiva, 

destaca-se o facto de os Serviços da Administração Central e Regional 

acusarem uma despesa muito mais comedida em 2013 reduzindo para, 

aproximadamente, 7% do valor de 2012, o total despendido na aquisição 

de Software SIG Proprietário. Em sintonia com esta tendência de redução 

drástica nas despesas com a aquisição deste tipo de software, também 

a Educação, os Serviços Municipalizados, a Segurança e a Saúde viram 

diminuídos os custos de forma bastante acentuada. O gráfico da Figura 5 

permite destacar a importância do volume de negócios gerado em torno 

da aquisição de Software SIG Proprietário por parte da Administração 
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Central e Regional e, se confrontado com os dados da Figura 4 e da Tabela 

2, rapidamente nos permite concluir que foram os anos de 2010, 2011 

e 2012, aqueles em que os serviços estatais da Administração Central e 

Regional “decidiram” que necessitavam de comprar/renovar licenças de 

Software SIG Proprietário.

Tabela 2 - Despesas de entidades públicas com Software SIG Proprietário em  Portugal, 
entre 2008-2013, por sector de actividade na administração pública - Valores em € 

Fonte: Base.gov

Figura 5 - Valores relativos às despesas de instituições públicas portuguesas com Software 
SIG Proprietário, por sector de actividade na Administração Pública. 

Fonte: Base.gov

Na Figura 6 apresentamos informação relativa à distribuição espacial 

das despesas efectuadas por organismos públicos, entre 2008 e 2013, para 

aquisição de Software SIG. Este cartograma realça uma polarização dos 

gastos com este tipo de software nas áreas metropolitanas de Lisboa e do 

Porto, à semelhança de outras variáveis sócio-económicas que demonstram 

as mesmas assimetrias - só Lisboa e o Porto concentram um volume total 
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de despesas na ordem dos 10 554 910 €. Não obstante, existe uma avul-

tada diferença entre os dois concelhos mais representativos das referidas 

conurbações (Lisboa - 9 163 880 €, e Porto - 1 391 030 €), o que pode 

ser explicado pelo facto de se concentrar em Lisboa, a grande maioria 

das sedes de organismos estatais com competências na coordenação do 

planeamento e do ordenamento territorial português.

Figura 6 - Valores relativos à distribuição espacial, por município, da despesa 
pública com Software SIG Proprietário, entre 2008 e 2013.

Fonte: Base.gov

Num outro plano, mas a merecer semelhante destaque, refere-se a 

elevada concentração de despesas com Software SIG Proprietário em 

áreas mais próximas do litoral entre Lisboa e o norte do País, pese em-

bora não se possa considerar uma faixa absolutamente contínua que liga 

Lisboa ao Porto. Nesta região destacam-se as despesas da responsabili-

dade dos municípios de Coimbra - 889 658 €, Leiria - 595 858 € e Viana 

do Castelo - 318 482 €. Por outro lado, há também alguns concelhos 

interiores que se destacam pelos elevados gastos com a aquisição de 

Software SIG Proprietário, designadamente, Évora - 340 293 € e Beja - 275 

540 €. Também alguns concelhos algarvios não escapam ao despesismo 

(evitável) com a aquisição de Software SIG Comercial, a olhar para os 
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exemplos que nos são fornecidos por concelhos como Loulé (396 036 €) 

ou Silves (151 058 €). 

Quanto às regiões insulares, na Região Autónoma da Madeira destaca-se 

o concelho do Funchal - 626 042 €, e na Região Autónoma dos Açores, 

Ponta Delgada - 459 492 €), valores que só se conseguem compreender 

por também aí estarem localizadas as sedes das delegações regionais de 

organismos da administração estatal. 

Apesar da matriz económico-social que define na litoralidade o prin-

cipal dos focos da política de desenvolvimento territorial em Portugal, 

importa também dizer que, o levantamento de dados efectuado neste 

estudo nos permitiu verificar que existem bastantes concelhos do interior 

do país que, mesmo não se destacando em termos absolutos no total dos 

custos com a aquisição de Software SIG Proprietário, compraram este 

tipo de software e gastaram dinheiros públicos em serviços a ele asso-

ciados, muitas vezes avultados. Esta constatação assume um cariz que 

não pode deixar de se envolver em alguma polémica e controvérsia, em 

algum descontentamento popular até, se pensarmos na matriz rural e de 

baixa densidade que estes concelhos representam e que as verbas para 

aí canalizadas poderiam ter tido como opção alternativa um investimento 

público em rubricas mais urgentes e/ou passíveis de gerar e atrair mais 

investimento, logo, atrair mais população. 

Os dados inventariados e recolhidos mostram que 48,6% dos concelhos 

do território continental praticaram gastos com este tipo de serviços para 

os quais existem alternativas de baixo custo ou, mesmo, nulo. Destes 

48,6%, 1,08% dizem respeito a concelhos com valores superiores a 1 000 

000 €, 2,2% a concelhos com valores acima dos 500 000 €, 12,9% a con-

celhos com valores acima de 100 000 € e 22,3% são relativos a concelhos 

cujos montantes envolvidos na aquisição de Software SIG Proprietário 

foram superiores a 50 000 €. Como complemento destes dados, conclui-se 

facilmente que 26,3% dos concelhos tiveram gastos inferiores a 50 000 €. 

4.2. Despesas com Software for Operating Systems - S4OS Proprietário

De acordo com os dados disponibilizados na Tabela 3, entre 2008 e 
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2013 o Estado português despendeu 88 202 790,31 € com Software S4OS 

(que, como anteriormente se referiu, inclui software de produtividade/es-

critório com posição claramente dominante no mercado), valor que acaba 

por ser muito mais significativo do que o apresentado para o Software 

SIG (com um delta igual a 63 449 880,92 €). Aquele valor traduz uma 

elevada dependência face a sistemas operativos patenteados por uma 

empresa (Empresa Z) que ocupa uma posição claramente dominante no 

mercado, mesmo em contexto mundial, posição que chegou a ser objecto 

de penalizações pesadas devido a procedimentos ilícitos praticados ao 

abrigo de um monopólio que esvaziava as possibilidades de implantação 

de concorrência. Em Portugal, o cenário reflecte o contexto mais amplo 

protagonizado por aquela empresa, o que por si só explica os valores 

encontrados. As soluções Open Source existem e começam a ser objecto 

de adesão crescente, mas a complexidade inerente ao desenvolvimento 

de soluções neste tipo de plataformas tem obstado a uma proliferação 

mais célere e expressiva. A formação de pessoal técnico, ainda que, 

com a finalidade de simples utilizador destes sistemas operativos, não 

é fácil, não é propriamente barata e, quando relegada para o plano do 

autodidatismo, torna-se numa solução muito morosa e assaz custosa e 

violenta. Os custos da migração devem, também nesta rubrica, ser muito 

bem ponderados e planeados, e devem partir de um inventário rigoroso 

e com critérios específicos para cada organismo e/ou serviço, no sentido 

da se avaliar, caso-a-caso, o Custo Total de Investimento - Total Cost of 

Ownership (TCO) e o Retorno do Investimento - Return of Investment 

(ROI). 

Analisando os dados da Tabela 3, destacamos o facto de os valores 

terem atingido uma expressão zenital generalizada no ano de 2009, 

com a área da Administração Central e Regional a protagonizar um im-

pressionante aumento da despesa em 2350% relativamente ao valor de 

2008. Os resultados nulos, sendo de difícil interpretação, não podem 

deixar de se associar a eventuais processos cíclicos de duração limitada 

dos sistemas operativos nativos dos equipamentos adquiridos em anos 

anteriores, processo em relação ao qual deverá ser atribuído também o 

significativo aumento generalizado da despesa, de 2012 para 2013 (já 
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com o OE 2013 em vigor). Os gráficos das Figuras 7 e 8 documentam a 

distribuição dos valores, absolutos e relativos (em %), envolvidos neste 

processo desde 2008. 

Tabela 3 - Custos com aquisição de Software S4OS Proprietário por 
organismos públicos do Estado português, entre 2008 e 2013 - 
dados relativos à empresa dominante no mercado (Empresa Z). 

Fonte: Base.gov

Figura 7 - Distribuição dos encargos de instituições públicas portuguesas com a 
aquisição de Software S4OS, entre 2008 e 2013. 

Fonte: Base.gov)

Ao derivarmos esta análise para uma comparação entre dados por dife-

rentes sectores de actividade da Administração Pública, percebe-se que a 

Administração Central e Regional, bem como os Serviços Municipalizados, 

foram quem mais gastou, muito embora o tenham feito de modo diferente, 

invertendo até a sua ordem relativamente ao Software SIG, na medida em 

que, na compra de Software S4OS à Empresa “Z”, em 2009, o primeiro 

dos sectores referidos foi o que mais gastou, (aproximadamente 17 400 
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000 € - 30% do total), enquanto os gastos relativos ao segundo dos sec-

tores referidos sendo de, aproximadamente, 2 600 000 € representa 23% 

(Figuras 8 e 9). Nesta contabilidade, destaca-se a classe “Outros Serviços” 

por se tratar de um conjunto de serviços implementados por empresas 

com alguma autonomia relativamente à máquina central do Estado e que 

nada têm a ver com a gestão do território; esse destaque faz-se notar 

pelos maiores gastos comparativamente a outros sectores (25%).

Figura 8 - Distribuição dos encargos (em %) de instituições públicas portuguesas 
wcom a aquisição de Software para Sistemas Operativos - S4OS, entre 2008 e 2013

Fonte: Base.gov

Por fim, em termos espaciais (Figura 9), à semelhança do que se 

constatou relativamente à espacialização dos custos com a aquisição/re-

novação de licenças de Software SIG, é visível uma polarização nas áreas 

metropolitanas de Lisboa (onde se destacam principalmente o concelho 

de Lisboa, mas também os de Almada e Oeiras) e do Porto, muito embora, 

tal como aconteceu anteriormente, exista uma assinalável diferença entre 

os dois concelhos polarizadores: Lisboa - 49 345 400 €, e Porto - 3 525 

440 €. O já referido efeito de “litoralização”, nesta componente de análise 

da distribuição espacial das despesas com a aquisição de Software S4OS 

por parte de organismos e instituições públicas portuguesas, diz respeito 

a uma região mais alargada uma vez que se incluem alguns municípios 

do litoral alentejano com valores bastante significativos, e cujo melhor 

exemplo é o do concelho de Odemira. Na banda sub-meridiana litoral, 
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destaque para Coimbra (1 406 390 €) e Braga (1 083 910 €). No interior 

do território continental, de uma forma geral, há diversos municípios com 

valores avultados, quase sempre bastante superiores, até, aos registados 

para o Software SIG. 

A legenda do cartograma da Figura 9 revela que 51,4% dos conce-

lhos do território continental celebraram pelo menos um contrato com a 

Empresa Z. Destes 51,4%, 2,2% dizem respeito a concelhos com valores 

superiores a 1 000 0000 € e 2,8% a municípios com cifras superiores a 

750 000 €; ainda assim, apenas 5,03% registam valores acima de 500 000 

€, cerca de 10% gastaram mais de 250 000, 21,6% dos quais denunciam 

valores superiores a 100 000 €, e 27,3% acima dos 50 000 €. Daqui resulta 

que 24,1% registaram valores inferiores a 50 000 €. 

Os valores de que há registo para as regiões insulares revelam que, 

no arquipélago da Madeira apenas as instituições sediadas no concelho 

do Funchal usufruem, de forma representativa, dos serviços da Empresa 

Z, e em relação à qual foi despendido um valor total de 3 454 990€ no 

período considerado, o que o torna num município a juntar aos 2,2% 

dos concelhos continentais com gastos superiores a 1 000 000 €, referi-

dos anteriormente. No arquipélago dos Açores, Ponta Delgada e Angra 

do Heroísmo com 5 528 760 € e 1 477 790 €, respectivamente, também 

se juntam a este grupo de concelhos com valores contratuais elevados. 

4.3. Teste comparativo de desempenho entre Software SIG Proprietário 

e Software SIG Livre

O teste comparativo de desempenho, descrito e apresentado em ru-

brica anterior deste documento, iniciou-se com um processo de recorte 

de um ficheiro raster - Carta de Risco de Incêndio Florestal de Portugal 

(CRIF). Foram utilizadas 9 (nove) máquinas, todas com sistema operativo 

Windows (7 ou 8), com processadores Intel (Core Duo ou múltiplo), com 

32 ou 64 bit, 4GB ou 8GB de RAM, e com um espaço em disco superior 

a 25 GB (o mais baixo das máquinas utilizadas). Esta tarefa foi sempre 

executada de modo exclusivo em cada equipamento, de forma a canali-

zar para o Software SIG em avaliação todos os recursos disponíveis em 

cada máquina.
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Figura 9 - Valores relativos à distribuição espacial, por município, da despesa pública com 
Software para Sistemas Operativos - S4OS Proprietário, entre 2008 e 2013.

Fonte: Base.gov

Os resultados obtidos na primeira das tarefas do teste de desempenho 

(Tabela 4) revelaram excelentes performances do QGIS 2.2 e do Software 

Proprietário 10.2, com o primeiro a conseguir ser quase sempre mais 

rápido no processamento do corte do raster5. Já o gvSIG foi considera-

velmente mais lento, o que mereceu uma nota de desagrado, entretanto, 

já reportada à Asociasión gvSIG6. Os resultados obtidos nesta tarefa 

concreta por parte da versão 2.0 do gvSIG foram tão mais decepcionan-

tes e desencorajadores quando pensamos nos excelentes resultados que 

este mesmo software revelou ao efectuar um processo semelhante de 

corte do mesmo raster, mas pela máxima extensão espacial do polígono 

em causa (distrito de Coimbra), evidenciando valores em torno de 1 se-

gundo em todas as máquinas utilizadas. No gvSIG urge rever, portanto, 

5 Este teste foi também efectuado numa máquina extra, com sistema operativo LINUX/
UBUNTU na qual havia sido instalada uma máquina virtual (GISVM), para se avaliar o 
desempenho do PostGIS. O resultado obtido - 24 segundos, foi conseguido seguindo o 
comando: time gdalwarp -s_srs EPSG:3763 -t_srs EPSG:3763 -multi -cutline cont_aad_
caop2013_distcoimbra.shp crif11e89.tif crif11e89_recortada.tif

6 No decurso, aliás, desta iniciativa, a Asociasón gvSIG solicitou a colaboração da 
Universidade de Coimbra no sentido do desenvolvimento de um algoritmo mais performante.
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as funcionalidades do algoritmo de corte para camadas raster com base 

numa shapefile, quando a Region of Interest (ROI) é coincidente com 

uma linha sinuosa. 

Tabela 4 - Tabela de resultados dos três software concorrentes para o 
recorte do raster (CRIF-Portugal continental) pela shapefile (single feature) 

com o limite do distrito de Coimbra

A segunda tarefa consistiu na utilização da mesma informação da 

CRIF-Portugal continental, mas em modelo de dados vectorial - formato 

shapefile; trata-se de um documento com 1,33 GB, e com uma arquitec-

tura de, aproximadamente, 3 500 000 features. O objectivo era proceder a 

uma tarefa semelhante com os três software concorrentes, cortando esta 

shapefile por uma outra - o limite do distrito de Coimbra que havia sido 

utilizado, também, na primeira tarefa, com o raster. Os resultados obtidos 

(Tabela 5) revelam agora uma vantagem clara do Software Proprietário. 

O desempenho dos dois representantes do Software Livre fica, de facto, 

muito aquém do do Software Proprietário, com o gvSIG 2.0 a revelar ser 

mais lesto do que o QGIS 2.2 a executar esta tarefa7.

7 Nesta tarefa (a mais exigente) tentámos igualmente efectuar o teste com uma máquina 
extra, com sistema operativo LINUX/UBUNTU (com e sem máquina virtual), para avaliar 
o desempenho do PostGIS. No primeiro caso, o processo de corte topológico da shapefile 
com cerca de 3 500 000 features demorou também mais de 30 minutos, e foi efectuado 
segundo a sequência:
CREATE TABLE clip(geom) AS SELECT st_intersection(a.geom, b.geom) as geom 
 FROM crif2011 a, caopdistcoimbra b WHERE st_intersects(a.geom, b.geom)
	 No segundo caso, ensaiámos uma sequência de comandos optimizada, que revelou 
melhores resultados mas, ainda assim, ligeiramente superiores a 12 minutos. Esta segunda 
sequência de comandos efectuados com PostGIS, da autoria de Frederic Lehodey, consistiu 
nos seguintes procedimentos:
	 create table teste_inter as
	 select
	  a.gid as crif_id,
	  b.gid as caop_id,
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Tabela 5 - Tabela de resultados dos três software concorrentes para o recorte 
da shapefile da CRIF-Portugal continental, pela shapefile (single feature) 

com o limite do distrito de Coimbra

5. Discussão dos resultados

A realização de um exercício desta natureza, como foi já referido, não 

pode ser imune a críticas, pelas diversas razões que foram igualmente já 

invocadas. Não obstante, julgamos que a sua materialização tal como se 

apresenta neste documento, pode ajudar a esclarecer a comunidade, em 

geral, e a comunidade científica, em particular, sobre aspectos de apreciável 

importância como sejam, por um lado, os custos associados à aquisição/

manutenção de licenças com Software Proprietário e, por outro lado, o 

grau de fiabilidade, desempenho e performance de alguns dos principais 

representantes do Software Livre, factores que podem pesar na equação 

(individual ou colectiva) que se formule no sentido de se avaliarem as 

vantagens e os inconvenientes da migração de um para o outro. Quanto 

à primeira das questões, não podemos deixar de concluir que valores 

como 24 752 909,08 € e 88 202 790,31 € gastos pelo Estado português 

entre 2008 e 2013, com Software SIG e Software para sistemas operativos 

proprietários, respectivamente, representam quantias bastante elevadas 

(evitáveis) tendo em conta os parcos recursos económico-financeiros de 

um país como Portugal, e a forte dependência da sua Economia face aos 

mercados e agentes externos. Tendo em conta que existem soluções de 

	  case
	  when ST_Within(a.geom,b.geom)
	  then a.geom
	  else ST_Multi(ST_Intersection(a.geom,b.geom))
	  end as geom
	 from crif2011 a join caopdistcoimbra b ON ST_Intersects(a.geom, b.geom)
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baixo custo ou, praticamente, de custo zero, e que essas mesmas solu-

ções se comportam de uma forma geral, de um modo muito semelhante 

ao Software Proprietário, seja em termos de fiabilidade, seja em termos 

de desempenho (sendo visíveis, apenas, algumas diferenças ao nível do 

desempenho em condições de processamento de grandes volumes de 

dados, uma vez que em termos de tipologia e quantidade de tarefas SIG 

as diferenças não são sensíveis), as vantagens de se passar a utilizar solu-

ções de Software Livre na Administração Pública portuguesa são evidentes 

e incontornáveis. Despender, aproximadamente, 113 000 000 € em seis 

anos com Software Proprietário é uma conduta que não se compreende! 

Outras práticas em países como o Brasil, Espanha, Itália e, mesmo, os 

resultados pioneiros decorrentes da migração que algumas instituições 

públicas portuguesas encetaram já no sentido da utilização de Software 

Livre, esclarecem quanto às vantagens deste tipo de software, em termos 

de gestão racional e eficiente dos dinheiros públicos mas, também, em 

termos de implementação de uma política de cidadania dirigida para os 

princípios e para os valores morais, ao desaconselhar procedimentos 

ilícitos (crack de software) por se tornarem desnecessárias com a utili-

zação de Software Livre. 

6. Conclusão

No início deste artigo assumimos como desiderato a procura de res-

postas para questões que agora recordamos:

1- Quanto gastam as nossas instituições públicas com Software 

Comercial; 

2- Seriam as diferenças de desempenho entre Software Comercial e 

Software Livre suficientes (e suficientemente importantes) para justificar 

os assinaláveis custos acometidos à aquisição e renovação de licenças de 

software Comercial, tanto mais que se trata de dinheiros públicos.

O desenvolvimento dos processos de inventariação e análise dos dados 

recolhidos através da plataforma Base.gov permitiu responder de forma 

clara a ambas:

1- Tendo por base apenas os valores relativos ao período 2008-2013, 
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disponíveis nesta plataforma, podemos concluir que 113 000 000€ é uma 

factura a pagar muito cara e escusada. Muito cara, porque os recursos 

económicos e financeiros do país não a permitem suportar, e porque este 

procedimento, generalizado a quase toda a Administração Pública, torna 

insustentável um processo de desenvolvimento económico e social coe-

so e sem assimetrias. É uma factura escusada, porque existem soluções 

alternativas em Software Livre, soluções que permitem fazer as mesmas 

tarefas sem custos com aquisição ou renovação de licenças.

2- As diferenças de desempenho entre Software Comercial e Software 

Livre não são suficientemente importantes de forma a inviabilizar um 

processo de migração, na medida em que, de um modo geral, o que 

aquele software faz, o Software Livre também faz. Diferenças ao nível da 

velocidade de processamento em contexto de grandes volumes de dados 

a processar, não parecem ser suficientemente importantes e dissuasoras 

da opção pelo Software Livre, se atendermos aos custos associados à 

aquisição de Software Proprietário e aos riscos decorrentes de procedi-

mentos ilícitos para contornar esses mesmos custos. Por outro lado, a 

adopção de normas e formatos abertos para o arquivo e transmissão de 

informação, que é uma das vias para alcançar a (desejada) plena interope-

rabilidade, permite a independência do fornecedor de software e garante 

a equidade no acesso à informação e serviços de natureza espacial por 

parte dos cidadãos e empresas, leitura que decorre da própria letra da 

legislação portuguesa sobre o assunto, em concreto, a Lei nº 36/2011 e 

a RCM nº 91/2012. Ora, o Software Livre, por natureza, é interoperável e 

adopta normas e formatos abertos. Acresce, ainda, o facto de o OE2013 

ser muito claro quanto à utilização de software na Administração Pública 

portuguesa. E porque este trabalho não quer desmerecer a integridade 

intelectual dos seus autores, clara e assumidamente fervorosos e incondi-

cionais adeptos do Software Livre, deve ser dito que há ainda um caminho 

robusto a percorrer pelas soluções de Código Aberto. 

Mas a Comunidade está atenta e, certamente, irá resolver ou, melhor, 

resolvendo, na esperança de que a jangada de SIG, que se vai movimen-

tando sem rumo, se converta numa plataforma comum, muito mais ampla, 

e que acabe, por fim, por encontrar a sua loxódroma.
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Observação: Os autores escrevem em conformidade com as normas 

em vigor antes da implementação do Novo Acordo Ortográfico.
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